Using Firefox

Wikibooks.org
On the 28th of April 2012 the contents of the English as well as German Wikibooks and Wikipedia projects were licensed under Creative Commons Attribution-ShareAlike 3.0 Unported license. An URI to this license is given in the list of figures on page 63. If this document is a derived work from the contents of one of these projects and the content was still licensed by the project under this license at the time of derivation this document has to be licensed under the same, a similar or a compatible license, as stated in section 4b of the license. The list of contributors is included in chapter Contributors on page 59. The licenses GPL, LGPL and GFDL are included in chapter Licenses on page 67, since this book and/or parts of it may or may not be licensed under one or more of these licenses, and thus require inclusion of these licenses. The licenses of the figures are given in the list of figures on page 63. This PDF was generated by the \LaTeX typesetting software. The \LaTeX source code is included as an attachment (source.7z.txt) in this PDF file. To extract the source from the PDF file, we recommend the use of http://www.pdflabs.com/tools/pdftk-the-pdf-toolkit/ utility or clicking the paper clip attachment symbol on the lower left of your PDF Viewer, selecting Save Attachment. After extracting it from the PDF file you have to rename it to source.7z. To uncompress the resulting archive we recommend the use of http://www.7-zip.org/. The \LaTeX source itself was generated by a program written by Dirk Hünniger, which is freely available under an open source license from http://de.wikibooks.org/wiki/Benutzer:Dirk_Huenniger/wb2pdf. This distribution also contains a configured version of the pdflatex compiler with all necessary packages and fonts needed to compile the \LaTeX source included in this PDF file.
Contents

1 Introduction 3
  1.1 About Firefox .......................... 3
  1.2 History of Firefox ....................... 3

2 Installation 5
  2.1 Getting Firefox .......................... 5
  2.2 Installing ............................... 5

3 Browsing with Tabs 9
  3.1 What are tabs? ......................... 9
  3.2 Create, close, and select tabs .......... 9
  3.3 Customization ........................... 10
  3.4 Multiple home pages .................... 10
  3.5 Bookmark Groups ....................... 10
  3.6 Middle click to close tabs on Linux .... 11

4 Searching and finding within documents 13
  4.1 Quick searches and keywords ............ 13
  4.2 Find Toolbar ............................ 15

5 User preferences 17
  5.1 Preferences ............................. 17

6 Extensions 33
  6.1 Blogging ................................. 33
  6.2 Bookmarks ............................... 33
  6.3 Developer Tools ......................... 33
  6.4 Download Tools ......................... 34
  6.5 Themes .................................. 34
  6.6 Miscellaneous ......................... 34
  6.7 Mouse gestures ......................... 35
  6.8 Navigation .............................. 35
  6.9 News .................................. 35
  6.10 Page Display ......................... 36
  6.11 Search tools ............................ 36
  6.12 Tabs and windows ..................... 36

7 Plug-ins 39
  7.1 What is a Plugin? ....................... 39
  7.2 Before You Install ..................... 39
  7.3 Available Plugins .................... 40
1 Introduction

1.1 About Firefox

Mozilla Firefox (originally known as 'Phoenix' and briefly as 'Mozilla Firebird') is a free, cross-platform, graphical web browser developed by the Mozilla Foundation and hundreds of volunteers. Its current release is Firefox 15.0, released in August 28, 2012.

Firefox strives to be a lightweight, fast, intuitive, and highly extensible standalone browser. Firefox has now become the foundation's main development focus. Firefox includes an integrated pop-up blocker, tabbed browsing, live bookmarks, built in Phishing protection, support for open standards, an extension mechanism for adding functionality and localization for Firefox in different languages. Firefox also attempts to produce secure software and fix security holes promptly. Although other browsers have introduced these features, Firefox is the first such browser to achieve wide adoption.

Firefox has attracted attention as an alternative to other browsers such as Microsoft Internet Explorer. As of January 2011, estimates suggest that Firefox's usage share is around 30% of overall browser usage worldwide and is the dominant browser in Europe by some metrics. Since its release, Firefox has significantly reduced Internet Explorer's dominant usage share.

1.2 History of Firefox

Before its 1.0 release on November 9, 2004, Firefox had already gained acclaim from numerous media outlets, including Forbes and the Wall Street Journal. With over 25 million downloads in the 99 days after its release, Firefox became one of the most downloaded free and open source applications, especially among home users. On October 19, 2005, Firefox had its 100 millionth download, just 344 days after the release of version 1.0. By January 31, 2009 Firefox had been downloaded 1 billion times.

Firefox has become the foundation's main development focus (along with its Thunderbird email client), and has replaced the Mozilla Suite as their official main software release.

Blake Ross began working on the Firefox project as an experimental branch of the Mozilla project. They believed that the commercial requirements of Netscape's sponsorship and developer-driven feature creep compromised the utility of the Mozilla browser. To combat what they saw as the Mozilla Suite's software bloat, they created a pared-down browser (then known as Phoenix, today known as Firefox), with which they intended to replace the Mozilla Suite. Ben Goodger currently works as the lead developer of Firefox.

Mozilla Firefox retains the cross-platform nature of the original Mozilla browser by using the XUL user interface markup language. Through Firefox's support of XUL, users may extend
their browser's capabilities by applying themes and extensions. Initially, these add-ons raised
security concerns, so with the release of Firefox 0.9, the Mozilla Foundation opened Mozilla
Update, a website containing themes and extensions "approved" as not harmful.

1.2.1 Standards

Support for software standards

The Mozilla Foundation takes pride in Firefox's compliance with existing standards, especially
W3C web standards. Firefox has extensive support for most basic standards including HTML,
XML, XHTML, CSS, ECMAScript (JavaScript), DOM, MathML, SVG, DTD, XSL and
XPath.

Firefox also supports PNG images and variable transparency.

Mozilla contributors constantly improve Firefox's support for existing standards. Firefox
has already implemented most of CSS Level 2 and some of the not-yet-completed CSS Level
3 standard. Also, work continues on implementing standards currently missing, including
APNG and XForms. Some of the Mozilla standards like XBL is also making its way to open
standards (via WHATWG).

http://en.wikipedia.org/wiki/PNG

http://en.wikibooks.org/wiki/Category%3A

http://it.wikibooks.org/wiki/Mozilla%20Firefox%2FIntroduzione
2 Installation

2.1 Getting Firefox

Firefox can be downloaded from this page\(^1\). Pressing the large green button will download Firefox. To get a version of Firefox in another language, see this page\(^2\).

2.2 Installing

![Firefox Windows Installer](image)

**Figure 1** Firefox Windows Installer

2.2.1 Microsoft Windows


To install, double click on Firefox Setup `<version>.exe` (where `<version>` is a number) and follow the installation instructions. Choosing the standard installation is recommended for most new users. This will install Firefox under Program Files.

---

2. [http://www.mozilla.org/products/firefox/all](http://www.mozilla.org/products/firefox/all)
You can run Firefox from the Program Files entry or by double-clicking the Firefox icon on your desktop. The first run of Firefox will give you the option of importing your settings from Internet Explorer (or any other browser installed on your computer). Choosing 'Yes' will import all your bookmarks (also known as favorites), saved passwords, history and browsing options. After it finishes importing all these settings, the Firefox browser will start up and a dialog box will pop-up alerting you that Firefox is not set as the default browser. Selecting 'Yes' will associate Firefox with web related files on your PC and Firefox will also open when links are selected from (most) external applications, such as from an instant messenger.

After setting Firefox as the default browser, it should automatically appear on the Windows XP new-style Start menu under the 'Internet' option. However, if it doesn't, it can be manually set. Right click on the Start button and select 'Properties'. From there, select 'Customize...', and select 'Mozilla Firefox' next to the 'Internet' checkbox.

![Firefox MacOSX Disc Image](image_url)

**Figure 2** Firefox MacOSX Disc Image

### 2.2.2 Mac OS X

Double click on the compressed Disk Image to mount it. Drag the Firefox application icon to the 'Applications' folder on your hard drive. Do not double-click the Firefox icon inside the Disk Image: doing so can cause a program hang. To make Firefox always appear in the dock, drag the icon from the 'Applications' folder to the dock.

### 2.2.3 Linux

Many distributions now come with Firefox included. Check your distribution's documentation for details. There should be a Firefox icon in your desktop environment's program menu.

If your distribution does not come with Firefox pre-installed, you may download it from the official Firefox website. Once the download is complete, decompress the file, which can be done usually by opening the file in a file archiver (such as ark or file roller) and extract it to another folder. Alternatively, typing `tar -xvzf firefox-<version>.tar.gz` or `tar
Installing-xvzf firefox* at a command line will generate directory named "firefox." This directory can be moved anywhere. Typing ./firefox in the shell from the install directory should run Firefox.

2.2.4 Other Operating Systems

Since the Mozilla Foundation makes the Firefox source code available, users can also compile and run Firefox on a variety of other architectures and operating systems. Operating systems not supported by Firefox, but known to run the browser include:

- Solaris (x86 and SPARC)
- OS/2
- AIX
- FreeBSD
- PC-BSD
- NetBSD
- BeOS
- SkyOS
- RISC OS (ARM)
- OpenBSD

3 it:Mozilla Firefox/Installazione
4 http://it.wikibooks.org/wiki/Mozilla%20Firefox%2FInstallazione
3 Browsing with Tabs

3.1 What are tabs?

Firefox has been designed to be useable by any user immediately—with no learning curve. However, to truly "rediscover the web", you should become comfortable with Firefox's advanced features. One of these is the use of tabs. Firefox uses 'tabs' to show multiple web pages in the same window. Several other web browsers, such as Internet Explorer 7 and Opera, also use tabs.

![Figure 3 The default look of Firefox, with tabs visible](image)

Tabs are featured underneath the Location and Bookmarks Toolbars, in a file folder-like layout. Tabs allow users to have one Firefox window in the taskbar, with multiple web pages open within that window. In the image, the default Firefox homepage is shown in the first tab, and Firefox Central\(^1\) (accessed from the 'Getting Started' bookmark) is shown in the second. The number of tabs that can be opened at any one time is unlimited, though the tab bar can only hold around 20 tabs comfortably. Also, Firefox does not display the tab bar unless more than one tab is open (there is an option to change this).

3.2 Create, close, and select tabs

There are many different ways to both create, close, and access tabs. First, a new blank tab can be created by clicking on File → New Tab, or by using the keyboard shortcut [Ctrl]+[T]. If the tab bar is visible, an empty space (i.e., one not occupied by a tab) can be right clicked, and 'New Tab' will create a new tab. Similarly, double clicking an empty space on the tab bar will create a new blank tab. Another way to create a tab, arguably the most common, is by clicking the middle mouse button (sometimes referred to as the third mouse button, or scroll wheel) on any link or bookmark (for instance, "Getting Started" in the above image). Finally, holding down the [Ctrl] key and left clicking a link will open that website in a new tab.

\(^{1}\) http://www.mozilla.org/products/firefox/central.html
There are also a variety of different ways to close tabs. First, File → Close or [Ctrl]+[W] will close the currently selected tab. Also, the red "x" on the right edge of the tab bar will close the current tab. Finally, middle clicking on any tab (it doesn't have to be selected), or right clicking and selecting 'Close Tab' will close whichever tab was selected.

Finally, there are a few different ways to select tabs. The most obvious is to simply left click on a tab. However, a keyboard shortcut also exists: [Ctrl]+[Number] where 'Number' is any number 1-9. The corresponding tab will then be selected. Of course, this only works for the first 9 tabs opened. Another common keyboard shortcut is [Ctrl]+[Tab]. This will make the next tab active. Using [Ctrl][Shift]+[Tab] will select the previous tab. These shortcuts are an easy way to cycle through the currently open web pages.

A new feature in Firefox 1.5 is the ability to 'Drag and Drop' tabs. By clicking and holding down the left mouse button on a tab, it is possible to change the order of tabs or put them on a different Firefox window. Once the desired location is found (as signaled by an arrow), the left button can be released, and the tab will be moved.

In addition to basic functionality, there are many other ways to use tabs.

### 3.3 Customization

For Tab preferences, see the chapter on Preferences\(^2\).

### 3.4 Multiple home pages

Tabbed browsing also enables another feature: multiple home pages. With multiple home pages, it is possible to have several pages open each time the browser is opened or the 'Home' button is selected.

To set multiple home pages, go to the 'Preferences' window, accessible from Tools → Options on Windows, Edit → Preferences on Linux, or Firefox → Preferences on OS X. Once in the Preferences window, select the General panel, and type each URL, separated by a pipe character (which is |), in the Home Page box. For example:


An easier way to set multiple homepages is to open all of the desired sites in tabs (making sure only the desired sites are opened) and then click the Use Current Pages button from the General tab of the Preferences window.

### 3.5 Bookmark Groups

Bookmarks Groups are very similar to Multiple Home pages. Bookmark Groups create a folder with multiple related (or unrelated, even) bookmarks. It is then possible to open all

\(^2\) Chapter 5.1.4 on page 27
of them at once by clicking on the created folder and clicking *Open in Tabs*. Alternately, you can simply open just one of the bookmarked web sites. To create a Bookmark Group, simply open each desired site in its own tab (again, be sure to **only** open the sites you'd like in the group). From there, a few ways exist to create a group:

- Right click on a tab and select *Bookmark All Tabs*...
- Click on *Bookmarks* → *Bookmark All Tabs*...
- Hit `[Ctrl]+[Shift]+[D]`

No matter which way you create the group, the same window will appear, asking you for a name and where to create the group.

### 3.6 Middle click to close tabs on Linux

When using Firefox on Linux, the default behavior when middle clicking is to try to load whatever is currently in the clipboard as if it were a URL. If you prefer to use the middle click to close tabs, type `about:config` in the location bar and hit enter.

In the new window that appears, type `middlemouse.contentLoadURL` in the box labeled *Filter*. Then, right click on the preference, and select *Toggle*, which should set the preference to *false*.

*(Another contributor writes: Unfortunately, in some versions—such as the one I'm using now—this simply causes Firefox to do nothing when you middle-click a tab. 'Twould be nice to figure out how to really fix this!)*

---


4 [http://it.wikibooks.org/wiki/Mozilla%20Firefox%2FNavigazione%20con%20schede](http://it.wikibooks.org/wiki/Mozilla%20Firefox%2FNavigazione%20con%20schede)
4 Searching and finding within documents

4.1 Quick searches and keywords

Figure 4  Select "Add a Keyword for this Search".

Figure 5 A Name and the Keyword \( w \) were just entered for this Quick Search.
Quick Searches allow you to define custom search keywords for entering in the Location Bar. After setup, just type your search keyword before your search terms. A wiki of popular quick searches is maintained [here](http://www.wormus.com/leakytap/Internet/CustomKeywords). The steps needed to make a new Quick Search are outlined below:

1. Go to a web page that contains a search box.
2. Right click in the search entry box.
3. Select 'Add a Keyword for this Search'.
4. Give your quick search a keyword. For example, a Wikipedia search could be \textit{w}. Obviously, shorter keywords are more efficient than longer ones, such as \textit{wikipedia}.

An alternative method for older versions of Firefox or locations without search boxes is to:

1. Go to a webpage that contains a search box.
2. Search for something. In this case, \textit{oddball} will be the search word.
3. Note the term in the URL, and replace it with \textit{\%s}. For example, searching on the Google search engine gives us the URL:

   \begin{verbatim}
   http://www.google.com/search?hl=en&q=oddball&btnG=Google+Search
   \end{verbatim}

   Using our example, the new address would be:

   \begin{verbatim}
   http://www.google.com/search?hl=en&q=\%s&btnG=Google+Search
   \end{verbatim}

   1. Copy the modified URL from the location bar.
   2. Go to \textit{Bookmarks} \rightarrow \textit{Manage Bookmarks} \rightarrow \textit{New Bookmark}.
   3. Paste your modified URL in the \textit{Location} box.
   4. Give your quick search a name, e.g. Google Quick Search.
   5. Give your quick search a keyword. \textbf{Note:} This can be one character or more. For example, a Google search could be \textit{g}.

   To use your new quick search all you need to do is type \textit{keyword your search term} in the address bar; for example, to search for the information regarding the history of Wikipedia in Google, you would type, \textit{g history of wikipedia}. You can also bookmark advanced searches using the same technique. Just try a search and replace your search term with \textit{\%s}. Simple!

   This functionality doesn’t have to be limited to web searches; it can be used to quickly go to pages that have a certain structure. For example, one way to get more out of Wikipedia would be to create a bookmark to \textit{http://en.wikipedia.org/wiki/\%s} with keyword \textit{w}. Getting to Wikipedia articles now only requires typing in \textit{w article title}.

   Another example is currency conversions. To easily convert from US dollars to Euro, one could create a bookmark to \textit{http://www.xe.com/ucc/convert.cgi?From=USD&To=EUR&Amount=\%s} and give it the keyword \$$. To convert a given amount (say \$50), all one has to do now is enter \$ 50 into the address bar (note the space, it’s very important).

   Once you start thinking about them, keywords can become quite useful.

---

1. http://www.wormus.com/leakytap/Internet/CustomKeywords
You can also use the SmartSearch\textsuperscript{3} extension to do all your quick searches from the context menu, by highlighting a word on a page, right-clicking it and search using any of your quick searches.

4.2 Find Toolbar

![Find Toolbar](image)

**Figure 6** Screenshot of performing 'Find as you type'. "ency" was being typed and the first matched text was highlighted in green.

A new and innovative feature is the Find Toolbar. The Find Toolbar is used for searching for text within a page without being too obtrusive. When activated by pressing Ctrl+F, the Find Toolbar appears on the bottom of the Firefox browser ready to search the current web page. The Find Toolbar using incremental searching which means that it will look up your search term simultaneously as you type it. This is more robust than traditional find as finding is done immediately when typing starts. The Find Toolbar has the ability to find the next or previous result and select it, highlight all the matched results and match case. Firefox will search down until reaching the end of the document and "wraparound" to the beginning of the page. If there are no results matching your terms, Firefox will 'beep' to inform you of this. (If you want to disable this 'beep' go to `about:config` and change the value `accessibility.typeaheadfind.enablesound` to `false`.) When you are done searching, simply press the Esc key and the Find Toolbar will hide.

4.2.1 Find As You Type

A very useful feature is Find As You Type, which lets you use the functionality of the Find Toolbar without having to open or close it with Ctrl+F or Cmd+F.

\textsuperscript{3} \texttt{http://update.mozilla.org/extensions/moreinfo.php?id=188}
By default, Find As You Type will only begin after pressing the / key. Alternatively, to only search links, press the ’ key (apostrophe). However, it is possible to have Find As You Type work without needing an additional key press. To do so, go to Tools → Options → Advanced → General and check "Begin finding when you begin typing".

From now on, when searching about some topic on a website, just start typing into the body of the page. You will instantly go to the first instance of the sequence of letters as you type. The Find Toolbar will temporarily appear at the bottom of the page, allowing you to highlight all the places the term occurs, or jump to the next one. More Find Toolbar shortcuts can be found in the ../Keyboard shortcuts/ section, and a complete description here5.

A useful tip to navigate around a web page is to use find as you type. You simply push the ’ key (apostrophe) and begin typing the text of the link you wish to follow. Once Firefox highlights that link (whether you’ve only typed a few letters or the entire word), you hit the Enter key and Firefox will begin loading that page. For example, if on this same page, you quickly want to go to the Table of Contents. Notice that the link for the table of contents is << To Contents. Press the apostrophe key to activate the Find Toolbar for searching for links and then type ’to’. Firefox will then highlight part of the link. Pressing enter will take you to the Using Firefox Table of Contents. One thing to note is that the apostrophe key does not necessarily have to be used for this tip to work; just using Find As You Type can accomplish the same thing, but since it searches all text, whether it’s a link or not, it may not be as quick as beginning your search with the apostrophe key.

4 Chapter 9 on page 45
5 http://www.mozilla.org/access/type-ahead/
6 http://en.wikibooks.org/wiki/Category%3A
5 User preferences

5.1 Preferences

To access the Preferences window, navigate to Tools → Options on Windows, Edit → Preferences on Linux, or Firefox → Preferences on OS X.

5.1.1 General

The General Tab of the Preferences window allows you to change a few things:

- Home Page
- Default Browser
- How Firefox connects to the Internet

The Home Page setting will most likely be the most used from this window, as the other two only need to be set once (if at all). There are four ways to set a home page from this window:

- Type an address into the Location(s): box (e.g., http://www.google.com)
- Select the Use Current Page(s) button, which will set the current page as the home page if only one is showing, or set all tabs as multiple home pages

\[\text{1 Chapter 3.4 on page 10}\]
• Select the Use Bookmark... button to open a dialog that will allow you to select a site currently bookmarked as the home page.
• Select Use Blank Page to have about:blank set as the home page.

The first time Firefox is launched, it will check if it is set as the default browser. The option Firefox should check to see if it is the default browser when starting, when checked, will make sure that Firefox remains the default browser (or, if Firefox is not the default browser, it will ask you each time if you’d like it to be). Also, pressing Check now will do the check after the browser has already been started.

The Connection Settings button only needs to be used if you use a proxy to connect to the Internet. If so, you can have Firefox auto-detect the settings, manually enter them, or use an automatic proxy configuration URL.

5.1.2 Privacy

The Privacy tab is described as follows: As you browse the web, Firefox keeps information about where you have been, what you have done etc. in the following areas: Each area has its own settings. As you select tabs inside the Privacy Tab, the main content area will change. However, there is one setting at the bottom of the window that is accessible from each tab. It says The Clear Private Data tool can be used to erase your private data using a keyboard shortcut or when Firefox closes. along with a Settings... button. Selecting that button will bring up a list of information that Firefox stores. Each can be set or unset individually. In addition to selecting which data you’d like cleared, there is an option to Clear private data when closing Firefox and another to Ask me before clearing private data. All private data that you have selected can be cleared at any time during a browsing session by hitting [Ctrl]+[Shift]+[Del].

Clearing private data is a public act that may, if your purpose was to keep some activity secret, expose that very secret. For a significant historical example see http://en.wikipedia.org/wiki/Soviet_atomic_bomb_project#Beginnings_of_the_program. Further, if “Clear Private Data” does not overwrite that data (and the prior paragraph does not so state) then that data may remain on your computer for some time and can possibly be accessed.
History

![Image of Privacy Tab with History selected]

**Figure 8** The Privacy Tab with History selected

The History tab has only two items:

- Remember visited pages for the last ___ day(s).
- A button to *Clear Browsing History Now*

These options are pretty self explanatory. Set the number of days you'd like Firefox to remember pages you have visited. Setting the value to 0 will cause Firefox to not use History. Pressing the *Clear Browsing History Now* button will erase all of the History.

The History is available from the *Go → History* menu item, by pressing [Ctrl]+[H], or by going to *View → Sidebar → History*. The *Go* menu itself also shows History.

History is an option for "Clear Private Data", and is selected by default.
Saved Forms

This tab, like the History tab, has only two items of interest:

- Save information I enter in forms and the Search Bar.
- Clear Saved Form Data Now

Checking the box (which is the default setting) will have Firefox save any data that is entered in a form. This includes things like the Google search box, any contact information (Name, Address, Email, etc) and other search boxes. Also, the Search Box included on the default Firefox toolbar (accessible by pressing [Ctrl]+[K]) Unchecking this box will stop Firefox from saving this information. Pressing the Clear Saved Form Data Now button will remove all the data currently stored by Firefox.

Saved Form Data is an option for "Clear Private Data", and is selected by default.

Note that you can clear out individual items (such as an erroneous or mis-typed entry) without having to clear all saved data. When the list of saved items shows up, navigate to the item you want to remove (don't click on it), then use the Shift-Delete key combination.
Preferences

Passwords

When *Remember Passwords* is checked (default), Firefox will present you with an option to save a password on any site where one is entered. After entering a password and hitting the submit button, Firefox will present a dialog with three options, *Remember, Never for This Site*, and *Not Now*. Selecting *Remember* will have Firefox store the password for that page, and will automatically enter it on each successive visit. Selecting *Never for This Site* will prevent Firefox from remembering the password for that page, and it will not ask to save a password on that page again. Selecting *Not Now* will prevent Firefox from saving the password on that visit, but the dialog will be presented again the next time you visit that site.

Firefox also has the option to set a Master Password. Without one, Firefox will automatically enter any password that is stored—regardless of who is using the browser at that time. A Master Password will cause Firefox to prompt the user for a password before it will enter any saved passwords. However, it will only prompt once *per session*, meaning as long as the browser remains open. To prevent unauthorized use of passwords, be sure to close the browser when you are finished using it (if you entered a Master Password). The Master Password can also be unset from this window.

Pressing the *View Saved Passwords* button will open a new dialog. This window shows every site that Firefox has a username/password saved for. At first, the address of the site and the username are displayed. Press the *Show Passwords* button to display the saved passwords. Individual entries can be removed by selecting them, and pressing *Remove*. All entries can be removed with the *Remove All* button.

Also on the *View Saved Passwords* dialog is a tab that displays *Passwords Never Saved*. This window is very similar to the *Passwords Saved* window. Removing an entry from this list, however, will cause Firefox to ask to save a password the next time you visit that site.

Saved Passwords are an option for "Clear Private Data", but are not selected by default.
Download History

Any time you download an item from the Internet, Firefox opens the Download Manager to track it. After the download is finished, Firefox will keep that item visible. Each item can be removed individually, or the entire history can be cleared at once. Also, Firefox can be set to never save a history (or clear the download history on its own, after each download). The Download Manager can be accessed by going to **Tools → Downloads**, or by pressing **[Ctrl]+[J]**. It can also be accessed by pressing the **View Download History** button on this pane of the Preferences window.

The only setting here affects how Firefox clears the Download Manager. **Remove files from the Download Manager:**

- Upon successful download
- When Firefox exits
- Manually (default)

**Upon successful download** will erase entries from the Download Manager as they finish downloading, **When Firefox exits** will clear the Download Manager history each time Firefox is closed, and **Manually** will leave all entries in the Download Manager until they are removed by the user.

**Note:** Removing files from the Download Manager **does not** delete the files from your computer. It only removes the history of you downloading it from Firefox.

Download History is an option for "Clear Private Data", and is selected by default.
Cookies

Cookies\(^2\) are "pieces of information stored by sites on your computer. They are used to remember login information and other data." This window can be a little more confusing than the others.

The first option, which is enabled by default, is *Allow sites to set Cookies*. Next to that option is a button named *Exceptions*. Setting exceptions will allow cookies from every site except for sites on the list.

Under that are two more options:

- *for the originating site only*
- *unless I have removed cookies set by the site*

Checking the first box will only allow cookies that are from the site you are currently on. For other sites to give you cookies, you will have to navigate to that site (with the option enabled; it is disabled by default). The second option will except all cookies, as long as you have not removed a cookie from that site. For instance, if you remove a cookie set by google.com, then google.com will no longer be able to send you cookies.

Beneath those options is a dropdown box. *Keep Cookies:*

- *until they expire* (default)
- *until I close Firefox*
- *ask me every time*

Each cookie has an expiration date. By selecting the first option, Firefox will keep each cookie until it expires, and then discard it. Selecting the second option will keep all cookies

only until Firefox is closed. The third option will make Firefox ask you each time a site tries to set a cookie, or modify an existing one.

Pressing the View Cookies button will bring up a new window, listing all cookies by site. From this window, it is possible to remove one, a few, or all cookies. Also, it is possible to view the contents of each cookie (though they are usually nonsensical).

Finally, the Clear Cookies Now button will clear all cookies.

Cookies are an option for 'Clear Private Data', but are not selected by default.

Cache

![Image of the Privacy Tab with Cache selected](image)

**Figure 13** The Privacy Tab with Cache selected

*Pages you view are stored in the cache for faster viewing later on.* As you visit pages, Firefox will automatically save copies of them. If you navigate to the same page later, Firefox will use the page saved rather than downloading it again. With this setting, you can set the size of the cache.

*Use up to ___MB of disk space for the cache.* The default value is 50.

Press the Clear Cache Now button to remove all pages from the cache.

Cache is an option for "Clear Private Data", and is selected by default.
5.1.3 Content

![Image of Firefox preferences pane]

**Figure 14** The Content Tab

The first setting on this pane is for blocking popups. Firefox is set to automatically enable all unwanted popups. The setting is *Block Popup Windows*, and is enabled by default. To the right is an *Allowed Sites* button, that lets you set sites to accept popup windows from. When a popup is blocked, the yellow "information bar" appears at the top of the window. From there, you can allow the popup that was blocked, or allow access for the site to open popups. Sites can be removed from the *Allowed Sites* list, which will cause Firefox to block popups from that site again.

Next is the *Warn me when web sites try to install extensions or themes*. This is also enabled by default. To the right of that is an *Exceptions* button. Any site that is not on the Exceptions list (which contains only addons.mozilla.org and update.mozilla.org by default) will be blocked from installing extensions or themes. A yellow information bar will appear at the top of the window, very similar to the one that appears when a popup is blocked. If you want to install an extension or theme from the current site, you can add it to the exceptions list, and then retry the install. If the install was unwanted (e.g., a web site tried to install a malicious extension), you don't need to take any further action, as the install was already blocked. Do not add the site to your exceptions list unless you want to install an extension/theme.

*Load images* is the next preference. It is enabled by default. This preference also has an *Exceptions* list, though it works slightly different from the extensions/themes exceptions list. From this list, you can both allow and deny permission for sites to load images. For instance, if the *Load images* preference is enabled, you can use the Exceptions list to deny specific sites the ability to load images. If, for example, you did not want wikibooks.org to load images, you would type "wikibooks.org" in the *Address of the web site* box, and hit *Deny*. All other sites would be allowed to load images as normal.

If the *Load images* preference was disabled, then no images would be downloaded. However, if (again for example) you wanted wikibooks.org to be *allowed* to load images, then you
would type "wikibooks.org" in the Address of the web site box, this time hitting Allow. All images would be blocked except images from wikibooks.org. Both types (allowed sites and denied sites) can be set at the same time, but would depend on the state of the Load images preference.

Below Load images is a preference (disabled by default) for the originating web site only. When enabled, images will only load if they come from the same site as the current page. However, this will not display images for such large sites as Yahoo! and Wikipedia, as images on those sites are stored on separate servers.

The preference Enable Java (enabled by default), controls whether or not Java applets are loaded in Firefox.

Enable JavaScript (enabled by default) controls whether or not JavaScript\(^3\) is executed by the browser. Pressing the Advanced... button will bring up a new window with the following options: Allow scripts to:

- Move or resize existing windows
- Raise or lower windows
- Disable or replace context menus
- Hide the status bar
- Change status bar text

The first three are enabled (meaning JavaScripts on a page will be able to do those actions) while the last two are disabled by default.

Finally, the Content tab contains Fonts & Colors settings. From this dialog, you can set the default font, and the default font size. The Advanced... dialog will allow you to select which specific fonts display which font type, and their sizes. The Colors... button allows you to set Link, Background, and Text colors.

5.1.4 Tabs

Figure 15  The Tabs tab

The first Tab-related preference is 'Open links from other applications in:'

- A new window
- A new tab in the most recent window
- The most recent tab/window

These options are mostly self explanatory. When another application (AOL Instant Messenger, for instance) tries to open a link, this preference will tell Firefox where to do it. The first two are easy enough to figure out, while the third will simply reuse the window that was most recently focused (replacing its contents).

The next preference is 'Force links that open new windows to open in:'

- The same tab/window as the link
- A new tab

This preference is sometimes referred to as 'Single Window Mode', as it prevents the 'target: _blank' and 'target: _new' attributes on links from opening new windows, always forcing Firefox to use one window. However, it has been disabled by default, as a few crashes have been reported with it enabled. There is little danger in enabling it, as it can be easily disabled again if a problem arises.

Three other preferences are on this window:

- Hide the tab bar when only one web site is open
- Select new tabs opened from links
- Warn when closing multiple tabs

The tab bar is hidden by default when only one website is opened. To have it always visible, uncheck the box next to the preference. 'Select new tabs opened from links' can be described as 'open a tab in the foreground'. In other words, with this preference enabled (it's disabled by default), a new tab opened by middle clicking a link will automatically be selected and
visible. The default behavior is to have the new tab open in the background, where you have to manually select it to view it. The final preference is visible by opening more than one tab and trying to close the window. A warning will be displayed to make sure all of the tabs can be closed.

It is also possible to extend tabbed browsing functionality through Firefox's extension system. See Chapter 6\(^4\) for more details on extensions.

### 5.1.5 Downloads

![The Downloads tab](image)

**Figure 16** The Downloads tab

The Downloads tab has several preferences. First, there is the option of setting a "Download Folder". If *Ask me where to save every file* is selected, then Firefox will prompt you for a location to save every file you download. Selecting *Save all files to this folder:* will make it so every download goes to the same location. The Desktop is the default location for downloads on Windows.

Next, *Show Download Manager when a download begins*, which is enabled by default. This brings up the download manager for each file that is downloaded. You will manually have to close the Download Manager unless the preference *Close the Download Manager when all downloads are complete* is selected.

The final preference states *Firefox can automatically download or open files of certain types*. Pressing the *View & Edit Actions...* button will bring up a new window. It contains a list of file extensions, and default actions for files of that type. Each file type can be set to automatically open with its default application, automatically open with a non-default application, saved to the computer, or opened with a plugin (assuming the correct plugin is installed). At this time, there appears to be no "Add" button, so you’re out of luck if the type you want to handle is missing from the list. Additionally, some users may have a blank dialog box (as of 8-8-2006), in which case none

---

\(^4\) Chapter 6 on page 33
of the extensions are listed. The issue is mentioned at http://forums.mozillazine.org/viewtopic.php?p=2400536&sid=d02c030728278592cbeb3ae9805b14b but the fixes described may not work for all users. Those users should locate their profiles folder (%AppData%\Mozilla\Firefox\Profiles\xxxxxxxx.default on WinXP where x is a random character), and delete the appropriate files there.

5.1.6 Advanced

This pane offers some advanced settings. There is a third tab offered under "Advanced", 'Security'. However, most users should not need to change any preferences on this tab.

General

![Advanced Tab with General selected](image)

Figure 17 The Advanced Tab with General selected

The setting *Allow text to be selected with the keyboard* controls **caret browsing**. When using caret browsing, a cursor is placed in the browser, and it can be moved with the arrow keys and used to select text. Pressing [F7] will also enable and disable this feature.

*Begin finding when you begin typing* is a setting for Find As You Type (FAYT). Normally, FAYT is activated only after pressing the / or ’ keys, or by pressing [F3]. With this setting enabled, FAYT will begin when any key is pressed (as long as the cursor is not in a form, or other text entry area).

*Resize large images to fit in the browser window* will automatically resize any image that is larger than the current browser window so that it fits in the window without causing scrollbars. Clicking on the image will display it at its full size, and clicking on it again will resize it to fit the window.

*Use autoscrolling* toggles the ability to autoscroll. With autoscroll enabled, click the middle mouse button to enter autoscroll mode. While in autoscroll mode, simply move the mouse
User preferences

up to scroll up, and move the mouse down to scroll down. Clicking the middle mouse button again will exit autoscroll.

*Use smooth scrolling* toggles the ability to make scrolling with the mouse wheel 'smoother' than normal.

Finally, click the *Edit Languages...* button to change the order of preference of languages for pages that offer more than one language.

**Update**

![Figure 18](image-url) The Advanced Tab with Update selected

The Update tab changes the way Firefox checks for updates for itself, extensions and themes, and search engines. All three should remain checked, as critical security updates will use the Update system.

The final preference determines how to install updates. If *Ask me what I want to do* is selected, then Firefox will alert you when new updates are found and wait for instructions. If *Automatically download and install the update* is selected, Firefox will apply updates without asking. However, if *Warn me if this will disable extensions or themes* is checked, and a new update may break a currently installed extension or theme, Firefox will display a warning.

Finally, select the *Show Update History* button to see a list of previously installed updates, and what they contained.

### 5.1.7 Multiple Users

With Firefox, it is possible to create many different *profiles* each with its own settings. This has several advantages, because it allows you to install the extensions you need for web development, while not slowing down your browser for normal surfing. The disadvantage is that only one profile can be running at the same time. To switch profiles, or add new profiles,
you need to run `firefox -profilemanager`. On Windows, this can be achieved by typing the command into the "Run" dialog on the start menu, on most other systems this can be run wherever a command may be run, usually a Terminal or Command Line.

This command must be run when firefox is not running on your computer, if it is running, you will just get a new window with the preferences for the currently active profile. The dialog box that opens when the command is run successfully allows you to select from a list of profiles. With each profile you have the option to either "Rename" or "Delete" it, or just to "Start Firefox" by using it.

When you delete a profile from the profile manager, it asks you whether you want to delete or keep the files that contain the information associated with it. If you select the delete files option, then all private data associated with that profile, including history, saved passwords, and cookies, are deleted from the hard drive. There is no reason to keep these files as creating a new profile under the same name as the deleted one will not restore the profile.

http://en.wikibooks.org/wiki/Category%3A
6 Extensions

Extensions are small add-ons that add new functionality to Firefox. They can add anything from a toolbar button to a completely new feature. They allow the browser to be customized to fit the personal needs of each user if they need additional features, while keeping Firefox small to download.

There are over 1000 extensions available for Firefox. This may make it difficult for people to find what they want. The links on this page are intended to help while also remaining current. As such they will not generally point to specific extension but rather where to look for them. To look at links by category this page is a good start. Additionally the headings below provide a link to mozilla.org pointing to the specific category - this means that the information will always be up to date.

A good place to start looking for extensions is here for recommended extensions.

The most popular extensions are to be found here.

There are many themes available at Mozilla Update which make Firefox more attractive. The most popular ones are here.

In addition, Mozilla has recently launched Fashion Your Firefox, a service for users who don't want to go through the entire library of addons to choose just a few good ones based on what they use Firefox for.

6.1 Blogging

6.2 Bookmarks

6.3 Developer Tools

- EditCSS- Stylesheet modifier in the Sidebar. Allows you to edit any site's CSS file on the fly.

1 https://addons.mozilla.org/firefox/extensions/
2 https://addons.mozilla.org/firefox/recommended/
5 https://addons.mozilla.org/en-US/firefox/fashionyourfirefox
- Web Developer Extension\(^7\)- Must have extension for anyone dabbling in web design.

### 6.4 Download Tools

- Download Statusbar\(^8\) — View downloads in an auto-hide statusbar.
- DownThemAll\(^9\) — Easily manage downloads while accelerating them as well.
- Video DownloadHelper\(^10\) — Download videos (FLV files; Flash Video; extension:*.flv) from sites like Youtube\(^11\) and other types of media including MP3 (Extension:*.mp3) etc.

### 6.5 Themes

- Vista-aero\(^12\) — A theme for Firefox meant to look like Internet Explorer 7; with Aero-like visual effects

### 6.6 Miscellaneous

- BBCode\(^13\) — Enables you to quickly and easily insert various BBCode tags in editable textboxes from the context menu. Very handy for customizing posts on forums.
- Calculator\(^14\) — A simple calculator extension.
- Calculator\(^15\) — An advanced calculator extension.
- Calendar\(^16\) — An iCal\(^17\) compatible Calendar for Firefox. You can download calendars for your favourite sports teams, etc., from iCal Share\(^18\)
- ChatZilla\(^19\) — A simple, straightforward Internet Relay Chat (IRC) client.
- Cookiepie\(^20\) — An extension to handle multiple web accounts simultaneously, opening many Gmail, Yahoo, Hotmail accounts in different tabs on the same browser.
- FoxyTunes\(^21\) — Adds media player controls within Firefox. Currently supports many different music players across multiple platforms.

---


\(^11\) [http://www.youtube.com](http://www.youtube.com)

\(^12\) [https://addons.mozilla.org/en-US/firefox/addon/4988](https://addons.mozilla.org/en-US/firefox/addon/4988)


\(^14\) [http://quicktools.mozdev.org/mozcalc/](http://quicktools.mozdev.org/mozcalc/)

\(^15\) [https://addons.mozilla.org/firefox/1194/](https://addons.mozilla.org/firefox/1194/)


\(^18\) [http://icalshare.com/](http://icalshare.com/)


Mouse gestures

- **Gmail Notifier**[^22] — A Gmail notifier that integrates into the browser's user interface.
- **FasterFox**[^23] — A simple-to-use performance and network tweaker. Fasterfox allows you to change certain settings to make Firefox load pages more quickly, depending on your computer speed and Internet connection.
- **Quick Note**[^24] — A note taking extension with advanced features.
- **StumbleUpon**[^25] — Lets you 'stumble upon' websites that have been recommended ('thumbed up') by friends and community members with interests similar to your own. See also StumbleUpon website[^26].
- **WebmailCompose**[^27] — Makes mailto: (email) links load a webmail mail compose window and adds a WebMailCompose link to the context menu. Now supports selected addresses.
- **Wikipedia**[^28] — Provides text formatting options in the context menu for use on wiki sites based on Mediawiki[^29], such as Wikipedia and Wikibooks.

### 6.7 Mouse gestures

- **All-in-one mouse gestures**[^30] — Enables you to use the mouse for a wide variety of customizable shortcuts.

### 6.8 Navigation

- **Linkification**[^31] — Injects CSS on the fly making text URLs clickable with the default option to suppress referrer information.
- **Paste & Go**[^32] — Lets you paste a URL from the clipboard and directly load it.

### 6.9 News

- **Sage**[^33] — A lightweight RSS[^34] and Atom feed[^35] aggregator. Very useful for viewing news from many sites.

[^26]: http://www.stumbleupon.com/
[^28]: http://wikipedia.mozdev.org/
[^29]: http://wikipedia.sourceforge.net/
[^31]: http://www.beggarchooser.com/firefox/
[^34]: http://en.wikibooks.org/wiki/RSS
6.10 Page Display

- Adblock Plus\(^{36}\) — Blocks or hides advertisements and other annoyances from web pages, while still retaining the correct page format. It is designed to allow you to block flash and image banners built into the web page, as well as scripts. You add your own filters using wildcards (*) for simple filters, or RegEx\(^{37}\) (regular expressions) for advanced ones. An excellent maintained set of filters is here\(^{38}\).

- Flashblock\(^{39}\) — Allows you to easily block flash animations. Flash animations are replaced with an icon you click to play. May conflict with Adblock Plus and crash on some flash-intensive sites.

- Image Zoom\(^{40}\) — Adds zoom functionality for images. Functionality is also included in the Mouse Gestures extension.

6.11 Search tools

- termBlaster\(^{41}\) — Lets you search selected text using search engines selected by context menu. It comes with 110+ search engines from encyclopedias to translators to web-search engines organized in folders.

- Dictionary Search\(^{42}\) — Looks up selected word in a (customizable) online dictionary. Functionality is also included in the SmartSearch extension, which lacks the 4 search limitation.

- Googlebar\(^{43}\) — The Google Toolbar for Firefox. Additionally, Googlebar Lite provides a simpler interface (which is recommended for new users). https://addons.mozilla.org/extensions/moreinfo.php?id=492

- Groowe Search Toolbar\(^{44}\) — Groowe Search Toolbar bundles Google toolbar, Yahoo, Ask Jeeves, Teoma, Amazon, Download.com and others. The application is available for Internet Explorer as well.

6.12 Tabs and windows

- Focus Last Selected Tab\(^{45}\) — Brings focus to the last selected tab when closing the active tab. Functionality is also included in the TabMix extension.

---

\(^{36}\) http://www.extensionsmirror.nl/index.php?showtopic=774  
^{37}\) http://www.regular-expressions.info/  
^{38}\) http://pierceive.com/  
^{39}\) http://flashblock.mozdev.org/  
^{40}\) http://update.mozilla.org/extensions/moreinfo.php?id=139&page=releases  
^{41}\) http://addons.mozilla.org/extensions/moreinfo.php?id=1720  
^{42}\) http://addons.mozilla.org/extensions/moreinfo.php?id=68&page=releases  
^{44}\) http://www.groowe.com/  
- Session Saver\textsuperscript{46} — Saves the open tabs when closing the browser, and restores them upon restarting it. Functionality is also included in the TabMix extension.

- Single Window\textsuperscript{47} — A simple extension that allows Mozilla to fully utilize the built-in tabbed browsing behavior. Traps links that would normally open in a new window. Functionality is also included in the TabMix extension.

- Tabbrowser Preferences\textsuperscript{48} — Enables enhanced control for tabbed browsing. Most functionality is also included in the TabMix extension. Recommended for users who would like to change the way tabs behave in Firefox.

- TabMixPlus\textsuperscript{49} An extension that allows considerable customisation in the use of tabs and windows as well as a "restore" function that is as useful (or better) then the built in FireFox one.

- Undoclosetab\textsuperscript{50} — Reopen a closed tab. Functionality is also included in the TabMix, SessionSaver, and Mouse Gestures extensions.

\textsuperscript{46} \url{http://extensionroom.mozdev.org/more-info/sessionsaver}
\textsuperscript{47} \url{http://update.mozilla.org/extensions/moreinfo.php?id=50&page=releases}
\textsuperscript{48} \url{http://update.mozilla.org/extensions/moreinfo.php?id=158&page=releases}
\textsuperscript{49} \url{https://addons.mozilla.org/firefox/1122/}
\textsuperscript{50} \url{http://update.mozilla.org/extensions/moreinfo.php?id=58&page=releases}
\textsuperscript{51} \url{http://en.wikibooks.org/wiki/Category%3A}
7 Plug-ins

7.1 What is a Plugin?

Firefox requires plugins in order to read or display special content from the websites. Plugins are programs that are integrated into Firefox that allows websites to provide content to you. Such content includes flash videos, java games and streaming video from the Internet. Examples of plugins are Flash\(^1\), RealPlayer\(^2\), and Java\(^3\). Plugins are a necessary component to truly access the Internet's interactive stuff.

A much more comprehensive list of plugins, with detailed installation instructions, is available at Mozilla Update\(^4\). Another valuable resource is Mozdev Plugins\(^5\).

7.2 Before You Install

7.2.1 Close Firefox before installing plugins

Firefox should be closed before running any plugin installation programs, as existing files may be overwritten during the installation process.

7.2.2 Using XPInstall to install plugins

Some plugins are available as XPInstall packages (XPIs), the same format as that for extensions. Where XPIs are available, it is recommended you use them as they often install the plugin automatically without you having to restart Firefox. After the XPI has finished installing, you should restart your browser.

7.2.3 Checking which plugins you have installed

To check what plugins you have installed, simply type `about:plugins` in the Location bar. This page will show which plugins are installed, what file types they are associated with and if the plugin is enabled or disabled.

---

1 Chapter 7.3.3 on page 40
2 Chapter 7.3.6 on page 41
3 Chapter 7.3.2 on page 40
4 [http://pfs.mozilla.org/plugins/](http://pfs.mozilla.org/plugins/)
5 [http://plugindoc.mozdev.org](http://plugindoc.mozdev.org)
7.3 Available Plugins

7.3.1 Adobe PDF Reader

In order to read .pdf files, you need to install a pdf reader. Adobe Reader, one of the more popular software, can do this. Simply go to Adobe's official site and download Adobe Reader. With Firefox closed, install Adobe Reader and it will also install the plugin necessary for Firefox to view PDF files. No other steps are necessary. Firefox will now open all PDFs from within a Firefox tab.

If you install Adobe Reader after Firefox, Adobe Reader will automatically select the right plugin. If you already have the latest version of Adobe Reader installed then Firefox will automatically use the plugin. Some people have problems with the Adobe Reader plugin in Firefox. The explanation and solution is here.

7.3.2 Java

The Java Plugin is part of the Java Runtime Environment (JRE, for short). The JRE installer will install the Java Plugin for Netscape 7.2 and Mozilla automatically.

To get the it simply go to java.com and click the 'Download Now!' button to download and install the latest JRE.

7.3.3 Macromedia Flash Player

When you encounter a site that makes use of Flash graphics, a yellow bar will appear at the top of the page telling you that there is a missing plugin preventing you from viewing all the content on the current page. Click on Install Missing Plugins button and the Mozilla Plugin Finder Service will appear automatically. After accepting the User Agreement from Macromedia, the necessary components to view Flash will be installed.

Alternately, you may install Macromedia Flash Player (without having to go to a site) by installing the plugin manually. Simply go here and click on the Macromedia Flash Player 8.0 link.

7.3.4 Macromedia Shockwave Player

Simply go to the Macromedia Shockwave site and download the plugin. When you are installing it, Firefox will appear in the list of browsers that you can install the plugin for. (Remember, Firefox should be closed when installing).

---

6 http://www.adobe.com/products/acrobat/readstep2.html
7 http://kb.mozillazine.org/index.phtml?title=Adobe_Reader
8 http://java.com/
9 http://plugindoc.mozdev.org/windows.html#Flash
10 http://sdc.shockwave.com/shockwave/download/download.cgi?
7.3.5 Quicktime Player (Windows & Mac)

Simply go to Apple's (the developer of Quicktime) website and download Quicktime\textsuperscript{11}. Installing Quicktime will install the appropriate plugin in order for Firefox to view .mov files.

7.3.6 RealPlayer

Simply go to Real's (the developer of RealPlayer) website and download the program\textsuperscript{12}. The RealPlayer installer will automatically detect your browser's plugins folder and install the plugin.

7.4 Uninstalling Plugins

A list of your installed plugins can be obtained from about:plugins. As a general rule, to remove a plugin, you remove the file listed in about:plugins for it. Typically a .dll file.

On a XP machine this can typically be found at c:\Program Files\Mozilla Firefox\plugins\it:Mozilla Firefox/Plug-ins\textsuperscript{13}

\textsuperscript{11} \url{http://www.apple.com/quicktime/download/}
\textsuperscript{12} \url{http://www.real.com/freeplayer/?rpr=rnwk}
\textsuperscript{13} \url{http://en.wikibooks.org/wiki/Category%3Ait:Mozilla_Firefox/Plug-ins}
\textsuperscript{14} \url{http://it.wikibooks.org/wiki/Mozilla%20Firefox%2FPlug-ins}
8 Mouse shortcuts

*Note: for Mac OS X, use the Command key in place of Control for all shortcuts listed.*

8.1 Standard Firefox Shortcuts

<table>
<thead>
<tr>
<th>Action</th>
<th>Keyboard Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back</td>
<td>Shift+Scroll down</td>
</tr>
<tr>
<td>Close Tab</td>
<td>Middle-click on tab</td>
</tr>
<tr>
<td>Decrease Text Size</td>
<td>Ctrl+Scroll down</td>
</tr>
<tr>
<td>Forward</td>
<td>Shift+Scroll up</td>
</tr>
<tr>
<td>Increase Text Size</td>
<td>Ctrl+Scroll up</td>
</tr>
<tr>
<td>New Tab</td>
<td>Double-Click on Tab Bar or Middle-click on Tab Bar</td>
</tr>
<tr>
<td>Open Link in Background Tab</td>
<td>Ctrl+Left-click or Middle-click on a link</td>
</tr>
<tr>
<td>Open Link in Foreground Tab</td>
<td>Ctrl+Shift+Left-click or Shift+Middle-click on a link</td>
</tr>
<tr>
<td>Open Link in New Window</td>
<td>Shift+Left-click on a link</td>
</tr>
<tr>
<td>Save Link As</td>
<td>Alt+Left-click on a link</td>
</tr>
<tr>
<td>Scroll line by line</td>
<td>Alt+Scroll</td>
</tr>
</tbody>
</table>

1. [it:Mozilla Firefox/Scorciatoie Mouse](http://it.wikibooks.org/wiki/Mozilla%20Firefox%2FScorciatoie%20Mouse)

9 Keyboard shortcuts

9.1 Standard Firefox Keyboard Shortcuts

Note: for Mac OS X, use the Command key in place of Control for all shortcuts listed.

- **Back**: Alt+Left Arrow (or Backspace on Windows)
- **Bookmarks**: Ctrl+B or Ctrl+I
- **Bookmark This Page**: Ctrl+D
- **Bookmark All Tabs**: Ctrl+Shift+D
- **Caret Browsing**: F7
- **Clear Personal Data**: Ctrl+Shift+Del
- **Close Tab**: Ctrl+W or Ctrl+F4
- **Close Window**: Ctrl+Shift+W or Alt+F4
- **Complete .com Address**: Ctrl+Enter
- **Complete .net Address**: Shift+Enter
- **Complete .org Address**: Ctrl+Shift+Enter
- **Copy**: Ctrl+C or Ctrl+Insert
- **Cut**: Ctrl+X or Shift+Del
- **Delete**: Del
- **Downloads**: Ctrl+J (Windows & Mac OS X only), Ctrl+Y (Linux only)
- **Find Again**: F3 or Ctrl+G
- **Find in This Page (Find As You Type)**: Ctrl+F or /
- **Find Previous**: Shift+F3 or Shift+Ctrl+G
- **Forward**: Alt+Right Arrow (or Shift+Backspace on Windows)
- **Full Screen**: F11 (not implemented on Mac OS X)
- **Group Your Tabs (Panorama)**: Ctrl+Shift+E
- **History**: Ctrl+H
- **Home**: Alt+Home
- **Location Bar**: F6 or Ctrl+L or Alt+D
- **New Tab**: Ctrl+T
- **Next Frame**: F6
- **Next Tab**: Ctrl+Tab or Ctrl+PageDown
- **New Window**: Ctrl+N
Open File                      Ctrl+O
Open Last Closed Tab          Ctrl+Shift+T
Open Location in New Tab      Alt+Enter
Page Source                   Ctrl+U
Paste                          Ctrl+V or Shift+Insert
Previous Frame                Shift+F6
Previous Tab                  Ctrl+Shift+Tab or Ctrl+PageUp or
                              Ctrl+Alt+Left Arrow
Print                          Ctrl+P
Redo                           Ctrl+Y (NOT Linux) or Ctrl+Shift+Z
Reload                         F5 or Ctrl+R
Save Page As                   Ctrl+S
Search                         see Find and Web Search
Select All                     Ctrl+A
Select Next Search Engine in  Ctrl+Down
Search Bar
Select Previous Search Engine in Ctrl+Up
Search Bar
Select Tab [1 to 8; last tab]  Ctrl+[1 to 8; 9]
Stop                           Esc
Text Size: Decrease            Ctrl+-
Text Size: Increase            Ctrl++
Text Size: Normal              Ctrl+0
Web Search                     Ctrl+K (or Ctrl+E on Windows & Mac
                              OS X, or Ctrl+J on Unix)
Undo                           Ctrl+Z
Start typing in address bar    Ctrl+L (Cmd + L on OS X)

it:Mozilla Firefox/Scorciatoie da Tastiera\(^1\) nl:Firefox/Sneltoetsen\(^2\)

---

\(^1\) [http://it.wikibooks.org/wiki/Mozilla%20Firefox%20Scorciatoie%20da%20Tastiera](http://it.wikibooks.org/wiki/Mozilla%20Firefox%20Scorciatoie%20da%20Tastiera)

\(^2\) [http://nl.wikibooks.org/wiki/Firefox%2FSneltoetsen](http://nl.wikibooks.org/wiki/Firefox%2FSneltoetsen)
10 Privacy

10.1 Clearing Private Data

10.1.1 History

It is possible to select individual history items to delete, by using the history side bar. You can open the history side bar by selecting from the menu the View -> Sidebar -> History option. Deleting singular items can be achieved by finding the item, right-clicking on it to
Privacy

get the context menu, and selecting *Delete*. Deleting multiple entries can be achieved by right-clicking the list to focus it (for left-clicking will open the web page under the mouse, and losing focus on the list) and using the up/down arrows, and shift+up/down to select blocks of entries. Pressing *Delete* on the keyboard will delete the selected history items.

It is possible to delete all history items by opening the preferences dialog on the menu at *Edit -> Preferences*, and clicking on the *Privacy* tab and then the *History* tab. A button will be there to *Clear Browsing History Now*. This will clear all history items.

Under this tab also, by changing the option *Remember my browsing history for X days*, to 0, history items will not be kept between sessions.

Auto-completed URLs will disappear as corresponding history items are deleted.

**10.1.2 Cookies**

![Options](image)

As you browse the web, Firefox keeps information about where you have been, what you have done etc. in the following areas:

- **History**
- **Saved Forms**
- **Passwords**
- **Download History**
- **Cookies**
- **Cache**

Cookies are pieces of information stored by sites on your computer. They are used to remember login information and other data.

- **Allow sites to set Cookies**
- **Exceptions**
- **for the originating site only**
- **unless I have removed cookies set by the site**

**Keep Cookies:** until they expire

- **View Cookies**
- **Clear Cookies Now**

The Clear Private Data tool can be used to erase your private data using a keyboard shortcut or when Firefox closes.

**Figure 20**
Cookies can be cleared by selecting the Privacy tab and then the Cookies tab under the user preferences from the menu at Edit -> Preferences. All cookies can be deleted by clicking the Clear Cookies Now button. Individual cookies can be cleared by clicking the View Cookies button to open the cookie viewing dialog. Selecting cookies and pressing Delete on the keyboard will delete those cookies.

By changing the option to Keep Cookies to Until I close Firefox, cookies will not be kept between sessions. Also it is possible to choose to block all websites from putting cookies on your computer unless you have explicitly allowed them to do so, by adding them to a list accessible from this tab.

10.1.3 Other Data

It is possible to delete other private data by using options under the Privacy tab of the user preferences. See Preferences¹ for more details.

If you just want to delete one or a few values from the saved (remembered) list of field (or form) values, navigate to the item you want to clear (don’t click on it, just ‘point’ to it), then use the Shift-Delete key combination to clear it.

10.1.4 Deleting All Private Data

You can delete all private data, including browsing history, cookies, cache, saved form data, passwords, and download history, by opening the Clear Private Data dialog under the menu in Tools -> Clear Private Data (or by pressing Ctrl-Shift-Delete on your keyboard). This will ask you to list your preferences as to what should be cleared from Firefox. If you want to do the same thing often in the future, you can deselect Ask me before clearing private data, and the dialog will not be cleared.

Your preferences for this option can be set in the user preferences dialog under the Privacy tab; there is a button down the bottom right that says Settings, which will effect this function.

10.1.5 Security Extensions

Stealther

This Firefox extension allows you to surf the web without leaving a trace on your local machine. It temporarily disables the following while it is active:

- Browsing History (Websites you've visited, no auto-complete of URL's) - Cookies (Doesn’t allow websites to store cookies *Warning* this could cause difficulties when trying to access user account or E-Mail) - Downloaded Files History (All the files you've downloaded) - Disk Cache (Any files normally stored on your local machine "i.e images" will not be stored for fast viewing) - Saved Form Information (Information that would be used during the save

¹ Chapter 5.1.2 on page 18
form feature in Firefox *i.e save user name and password on this computer?* will not work
- Sending of ReferrerHeader. (When you click on a link from one web page or website to
another, the browser usually sends a Referer/header to the server to tell sites where you
came from.)

**NoScript**

'Winner of the '2006 PC World World Class Award", this tool provides extra protection to
your Firefox. It allows JavaScript, Java and other executable content to run only from trusted
domains of your choice, e.g. your home-banking web site, and guards the 'trust boundaries'
against cross-site scripting attacks (XSS). Such a preemptive approach prevents exploitation
of security vulnerabilities (known and even unknown!) with no loss of functionality... Experts
do agree: Firefox is really safer with NoScript ;-)’ -Giorgio Maone

**WOT**

'Can you recognize good and reliable Internet content? Did you have a bad experience that
you would like to share with others? WOT can help you. Seeing website reputations on your
browser allows you to learn from other people. This shared knowledge makes it easier to
avoid online fraud, including phishing and spyware. WOT can add reputations also to web
search results, Digg, Gmail, Wikipedia, and other selected sites." -Against Intuition, Inc.

'This of course preserves your privacy to great extent' - Anonymous

**CookieSafe**

'This extension will allow you to easily control cookie permissions. It will appear on your
statusbar. Just click on the icon to allow, block, or temporarily allow the site to set cookies.
You can also view or clear the cookies and exceptions by right clicking on the statusbar icon.
For safer browsing you may choose to deny cookies globally and then enable them on a per
site basis.' -Ron Beckman

---

2 http://en.wikibooks.org/wiki/Category%3A
11 Advanced configuration

11.1 about:config

Type about:config into your address bar and you will be brought to the about:config settings. This is a powerful way to tweak your settings in ways that are not normally accessible through the Options menu. By simply double clicking one of the available options (after copying and pasting them into the filter bar to find them easily), changes can be made, including the following:

- browser.block.target_new_window — if set to true, links that normally force a new window to open will open in the current window instead.

- browser.xul.error_pages.enabled — if set to true, Firefox displays an error page similar to IE instead of a message box if loading a page fails.

- layout.frames.force_resizability — if set to true, allows the user to resize frames on any web site that uses them.

The following changes can be made to speed up browsing. Normally the browser will make one request to a web page at a time. When you enable pipelining it will make several at once, which usually speeds up page loading. Make these changes to enable pipelining:

Set "network.http.pipelining" to "true"

Set "network.http.proxy.pipelining" to "true"

[Tip: If have your browser set to connect to an optional http proxy, you can leave "network.http.pipelining" setp to "false", then add the domains of websites that don't work with pipelining (like images.google.com) to the proxy exclude list.]

Set "network.http.pipelining.maxrequests" to 8. This means it will make up to 8 requests at once rather than the default of 4. This is only an advantage if you have a reliable internet connection that isn't particularly slow.

Finally, right-click anywhere and select New-> Integer. Name it "nglayout.initialpaint.delay" and set its value to '0'. This value is the amount of time the browser waits before it acts on information it receives, but it will increase the total time taken to render the page. This option is more suitable for a faster computer ('250' is the default). Try a value of '100' if '0' causes problems.

For broadband users:

Set "network.http.max-connections-per-server" to 14. Many guides recommend setting this figure to 100, but this can have undesirable effects upon webservers.

Set "network.http.max-connections" to 48
A much more complete list can be found here\(^1\), with descriptions and which values the preference will take (where applicable).

### 11.2 Editing the userChrome.css File

userChrome.css is a file that allows you to change the appearance of Firefox with CSS rules. The actual browser window (i.e., not the webpage, but everything else) is called the 'chrome'. The file userChrome.css overrides default settings to allow for more customization.

userChrome.css is not created by default. It should be created in your profile folder, which can be found in the following places:

- **Windows:** `%appdata%\Roaming\Mozilla\Firefox\Profiles\<Profile name>\`
- **Linux:** `˜/.mozilla/firefox/<Profile name>/`
- **Mac OS X:** `˜/Library/Mozilla/Firefox/Profiles/<Profile name>/` or `˜/Library/Application Support/Firefox/Profiles/<Profile name>/`

In all cases, the profile is randomly named, with 8 characters followed by `.default`. Inside that folder is another named "chrome". Inside the chrome folder is where userChrome.css needs to be created.

### 11.3 Editing the userContent.css File

### 11.4 Tips

- Allowing extension downloads from mozilla.org instead of www.mozilla.org will match all subdomains of mozilla.org, just as blocking cookies from doubleclick.net instead of www.doubleclick.net will allow blocking of all doubleclick.net subdomains. Allowing "www.mozilla.org" would not allow "addons.mozilla.org". However, as a security measure, when whitelisting sites for extensions, the most specific domain available should be used (i.e., addons.mozilla.org instead of mozilla.org) to prevent potentially malicious installs from other subdomains on a site.

- To get Firefox on a computer without an internet connection or where internet downloads are blocked you can download the file as normal from another computer (usually you can do this at a public library) then put the *.exe file on some removable media and transfer it to the first computer.

---

12 Developers tools

12.1 Extension Development

The most comprehensive site for Extension development is at the Mozillazine Knowledge Base found here\(^1\). Other helpful tools include the DOM Inspector\(^2\) included in Firefox and the JavaScript console.

Firefox is especially developer-friendly. It allows even the most casual web developer to crib useful HTML techniques from most any website they visit, and offers a host of other features for more serious users.

12.2 Source viewing

Perhaps the most-used development feature is the ability to highlight images and text in any website, and choose to view source from a drop-down menu. When this feature is used, Firefox displays the HTML source that was used to generate the highlighted content.

For instance, highlighting the above paragraph and section heading, right clicking, and choosing "View Selection Source", will display the following in a new window:

```html
<p>a name="Source_viewing" id="Source_viewing"></a></p>
<h2>Source viewing</h2>
<p>Perhaps the most-used development feature is the ability to highlight images and text in any website, and choose "View selection source" from the drop-down menu. Doing this will bring up a pop-up window, with the HTML source that was used to generate the highlighted content.</p>
```

Combining this technique with a good markup language reference source, such as the Wikibook\(^3\) HTML Programming\(^4\), will allow you to learn from every new website you visit.

\(^5\) it:Mozilla Firefox/Sviluppatori\(^6\)

---

1. http://kb.mozillazine.org/Extension_development
6. http://it.wikibooks.org/wiki/Mozilla%20Firefox%2FSviluppatori
13 Creating an extension

13.1 Introduction

This tutorial will explain step by step how to deploy an extension for Firefox 3. In this way the reader could implement in a easy way extensions that let personalize their version of Firefox, taking care about the compatibilities with Firefox 3.0*.

The first chapter gives a brief introduction to the extensions for Firefox. Then it will discuss some items that the developer must have considered about the compatibilities.

The second chapter starts to describe step by step how to deploy the extension and then, the last chapter will explain how to make the install file and how to install it.

13.2 Extensions for Firefox 3.0.*

This chapter will introduce the topic of what are the extensions and what functionalities they give. And for last the topic of compatibility.

13.2.1 What are the extensions?

An extension is a new functionality that is integrated to Firefox. These one can be deployed independent from the browser and from the platform. So we can say that extensions let users to bring new features, functionalities and behaviors to the browser.

The extensions are not the same as plug-ins. A plug-in allows for the viewing of web content that the browser cannot show by itself, for example: pdf, flash, sounds and videos.

13.2.2 Compatibility with Firefox 3.0.*

Some functions of JavaScript are not longer supported in the new releases of Firefox, especially over versions 3.p.*. Also the structures of the manifest files and the reference to the browses.xul have been changed. It is important to know about that changes, if not the extension could be incompatible with the last versions of Firefox. Other items to consider are the Managers that Firefox implements (ex, loginManager). These have been suffered changes too. For more information: Updating....
13.3 Start creating an extension.

The next chapter describes step by step how to develop simple extensions. It’ll specify the folders that must be created, the structure that must follow the type of files and the root folder.

13.3.1 Structure of folders

There is an obligatory structure that the folders must carry out. This structure defines the names of the folders, the hierarchical structure, the type of files of each folder and the place where these folders and files should be stored for bean recognized for Firefox.

13.3.2 Root folder

At the beginning we must create a folder with the name of the extension. This name must be unique and match the name defined in the installation file. There are two ways of naming the root folder of an extension.

As mentioned, this name must be unique, so the first alternative is to generate a GUID identifier for it. In Windows you can use the guidgen command and in Linux the uuidgen command. For example, you can generate this {1ca6f699-f8f3-479b-983b-20775f09f755}. The second alternative is to create a name with e-mail format. It is not recommendable to use a personal e-mail, only should have the same format. For example, we can call our extension like myextension@somedomain.

Inside the root folder we’ll create the structure corresponding to the extension.

13.3.3 Chrome Folder

1

---

14 External Links

14.1 Helpful Links

- Why switch to Firefox?¹ — Reasons to switch.
- Portable Firefox² — John Haller has repackaged firefox to be run from a removable storage device (such as a USB key or a zip disk).
- Spread Firefox³ — Firefox marketing.

14.2 Getting Started

- Firefox Help⁴ — Online Help for the Mozilla Firefox Web Browser
- Getting started with Mozilla Firefox⁵
- MozillaZine Knowledge Base wiki⁶
- Mozilla Community wiki⁷
- MozillaZine Forums⁸. If you have any problems with Firefox this should be your first port of call.
- Firefox Resources⁹
- Firefox Guide¹⁰ Simplified guide for the Firefox browser and all its resources

14.3 Plugins, Extensions, and Tweaks

- PluginDoc¹¹ — Lists common plugins and how to install them in Firefox.
- Mozilla Addons¹² — Official Mozilla site for plugins, extensions and themes.
- Addonsmirror.net¹³ — unofficial extension database (Formerly extensionsmirror.nl)

¹ http://www.switch2firefox.com/whyswitch/
² http://johnhaller.com/jh/mozilla/portable_firefox/
³ http://spreadfirefox.com/
⁴ http://www.mozilla.org/support/firefox/
⁵ http://www.edafe.org/tag/firefox/
⁶ http://kb.mozillazine.org/
⁷ http://mozilla.wikicities.com/
⁸ http://forums.mozillazine.org/
⁹ http://loadaveragezero.com/app/drx/Internet/WWW/Clients/Browsers/Firefox
¹⁰ http://www.browserfirefox.com/
¹¹ http://plugindoc.mozdev.org/
¹² https://addons.mozilla.org/
¹³ http://www.addonsmirror.net/
• Firefox Tweak Guide\(^\text{14}\) — Has some great tweaks for speed and various other customizations.

• How to write Firefox extensions\(^\text{15}\) — Tutorial for creating Firefox extensions, which includes a "Hello, world!" extension to explain the basics.

\(^\text{16}\) it:Mozilla Firefox/Links\(^\text{17}\)

\(^\text{18}\) es:Mozilla Firefox/Texto completo\(^\text{18}\)
15 Contributors

<table>
<thead>
<tr>
<th>Edits</th>
<th>User</th>
</tr>
</thead>
<tbody>
<tr>
<td>13</td>
<td>*nix⁴</td>
</tr>
<tr>
<td>11</td>
<td>Adrignola²</td>
</tr>
<tr>
<td>12</td>
<td>Alerante³</td>
</tr>
<tr>
<td>1</td>
<td>Anyseo⁴</td>
</tr>
<tr>
<td>1</td>
<td>Brian Brondel⁵</td>
</tr>
<tr>
<td>2</td>
<td>Conrad.Irwin⁶</td>
</tr>
<tr>
<td>1</td>
<td>Coolgamer⁷</td>
</tr>
<tr>
<td>4</td>
<td>Dancornett⁸</td>
</tr>
<tr>
<td>13</td>
<td>Darklama⁹</td>
</tr>
<tr>
<td>1</td>
<td>DavidCary¹⁰</td>
</tr>
<tr>
<td>1</td>
<td>Derbeth¹¹</td>
</tr>
<tr>
<td>2</td>
<td>Dirk Hünniger¹²</td>
</tr>
<tr>
<td>11</td>
<td>Dlrohrer2003¹³</td>
</tr>
<tr>
<td>1</td>
<td>DropDeadGorgias¹⁴</td>
</tr>
<tr>
<td>1</td>
<td>Ekevu¹⁵</td>
</tr>
<tr>
<td>25</td>
<td>Everlong¹⁶</td>
</tr>
<tr>
<td>1</td>
<td>Fedora.Pirate¹⁷</td>
</tr>
<tr>
<td>1</td>
<td>FireBobGibons¹⁸</td>
</tr>
<tr>
<td>2</td>
<td>Geeke¹⁹</td>
</tr>
<tr>
<td>7</td>
<td>Herbythyme²⁰</td>
</tr>
<tr>
<td>1</td>
<td>Jameshales²¹</td>
</tr>
</tbody>
</table>

12 http://en.wikibooks.org/w/index.php?title= User:Dirk_H%C3%8cniger
Contributors

1 Jbond64
2 Jguk
3 JoeAxon
4 Joelf
5 Kathleen.wright
6 Kernigh
7 LouCypher
8 Mahanga
9 Martinman11
10 Mattisse
11 Midnightcomm
12 Mjbmrbot
13 Nathan8225
14 Norm
15 Phoenix Hacker
16 Pietrodn
17 Polyparadigm
18 Poop
19 Pureblade
20 QuiteUnusual
21 Ramac
22 Rwwww
23 Steeler fan
24 Talkie Toaster
25 Techman224

1  Tinchomaru\textsuperscript{47}
1  Whiteknight\textsuperscript{48}
3  Xaque\textsuperscript{49}
4  Xp54321\textsuperscript{50}

\textsuperscript{47} http://en.wikibooks.org/w/index.php?title=User:Tinchomaru
\textsuperscript{49} http://en.wikibooks.org/w/index.php?title=User:Xaque
\textsuperscript{50} http://en.wikibooks.org/w/index.php?title=User:Xp54321
List of Figures

- cc-by-sa-3.0: Creative Commons Attribution ShareAlike 3.0 License. http://creativecommons.org/licenses/by-sa/3.0/
- cc-by-sa-2.5: Creative Commons Attribution ShareAlike 2.5 License. http://creativecommons.org/licenses/by-sa/2.5/
- cc-by-sa-2.0: Creative Commons Attribution ShareAlike 2.0 License. http://creativecommons.org/licenses/by-sa/2.0/
- cc-by-sa-1.0: Creative Commons Attribution ShareAlike 1.0 License. http://creativecommons.org/licenses/by-sa/1.0/
- cc-by-2.0: Creative Commons Attribution 2.0 License. http://creativecommons.org/licenses/by/2.0/
- cc-by-2.0: Creative Commons Attribution 2.0 License. http://creativecommons.org/licenses/by/2.0/deed.en
- cc-by-2.5: Creative Commons Attribution 2.5 License. http://creativecommons.org/licenses/by/2.5/deed.en
- cc-by-3.0: Creative Commons Attribution 3.0 License. http://creativecommons.org/licenses/by/3.0/deed.en
- PD: This image is in the public domain.
- ATTR: The copyright holder of this file allows anyone to use it for any purpose, provided that the copyright holder is properly attributed. Redistribution, derivative work, commercial use, and all other use is permitted.
- EURO: This is the common (reverse) face of a euro coin. The copyright on the design of the common face of the euro coins belongs to the European Commission. Authorised is reproduction in a format without relief (drawings, paintings, films) provided they are not detrimental to the image of the euro.
- CFR: Copyright free use.

Copies of the GPL, the LGPL as well as a GFDL are included in chapter Licenses. Please note that images in the public domain do not require attribution. You may click on the image numbers in the following table to open the webpage of the images in your webbrowser.

51 Chapter 16 on page 67
<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Original uploader was Steeler fan(^{52}) at en.wikibooks(^{53}). Later version(s) were uploaded by Adrignola(^{54}) at en.wikibooks(^{55}).</td>
</tr>
<tr>
<td>4</td>
<td>GFDL</td>
</tr>
<tr>
<td>5</td>
<td>Original uploader was Steeler fan(^{56}) at en.wikibooks(^{57}).</td>
</tr>
<tr>
<td>6</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Original uploader was Steeler fan(^{58}) at en.wikibooks(^{59}).</td>
</tr>
<tr>
<td>8</td>
<td>Original uploader was Steeler fan(^{60}) at en.wikibooks(^{61}).</td>
</tr>
<tr>
<td>9</td>
<td>Original uploader was Steeler fan(^{62}) at en.wikibooks(^{63}).</td>
</tr>
<tr>
<td>10</td>
<td>Original uploader was Steeler fan(^{64}) at en.wikibooks(^{65}).</td>
</tr>
<tr>
<td>11</td>
<td>Original uploader was Steeler fan(^{66}) at en.wikibooks(^{67}).</td>
</tr>
<tr>
<td>12</td>
<td>Original uploader was Steeler fan(^{68}) at en.wikibooks(^{69}).</td>
</tr>
<tr>
<td>13</td>
<td>Original uploader was Steeler fan(^{70}) at en.wikibooks(^{71}).</td>
</tr>
<tr>
<td>14</td>
<td>Original uploader was Steeler fan(^{72}) at en.wikibooks(^{73}).</td>
</tr>
<tr>
<td>15</td>
<td>Original uploader was Steeler fan(^{74}) at en.wikibooks(^{75}).</td>
</tr>
<tr>
<td>16</td>
<td>Original uploader was Steeler fan(^{76}) at en.wikibooks(^{77}).</td>
</tr>
<tr>
<td>17</td>
<td>Original uploader was Steeler fan(^{78}) at en.wikibooks(^{79}).</td>
</tr>
<tr>
<td>18</td>
<td>Original uploader was Steeler fan(^{80}) at en.wikibooks(^{81}).</td>
</tr>
<tr>
<td>19</td>
<td>Original uploader was Steeler fan(^{82}) at en.wikibooks(^{83}).</td>
</tr>
</tbody>
</table>

71 [http://en.wikibooks.org](http://en.wikibooks.org)
75 [http://en.wikibooks.org](http://en.wikibooks.org)
77 [http://en.wikibooks.org](http://en.wikibooks.org)
| 20 | Original uploader was Steeler fan⁸⁴ at en.wikibooks⁸⁵ |
16.1 GNU GENERAL PUBLIC LICENSE

This License, designated the GNU General Public License ("GPL"), is intended to ensure that the authors and distributors of free programs have the freedom to distribute copies without changing them in any way during the lifetime of those copies. It is not intended to apply to works that are not free.

The GPL applies to many programs, as indicated in the list below.


2. Propagation by Serial Copying.

3. Distribution of Modified Versions.

4. Revised Versions of the GPL.

5. Conveying Non-Source Forms.

6. Conveying Corresponding Source.

7. Additional Permissions.

8. Termination.


10. End of this License.

This License explicitly affirms your unlimited permission to make or receive copies of a covered work, and permits anyone to do so who agrees to give you all of the rights you have.

A "Standard Interface" means an interface that either the published specifications or the actual implementation are published, and all developers and distributors of a version of the program must be granted access to that interface in that work.

The "source code" for a work means the preferred form of the work for making modifications to it. "Object code" means any non-source form of a work.

A "work" means the original program along with any modifications made to it, and all derivative works by whatever name or form. A "Major Component" means either the complete Corresponding Source of a work, or any component, interface or derivative that is designed to interoperate with the work in the same manner. A "Minor Component" means any component of a work other than a Major Component.

If you convey a work based on the Program, or the modifications to produce it from the Program, the conveying occurs under a license that either (a) is included in the normal form of packaging a Major Component, or (b) the user may choose to apply in lieu of any license contained therein. This requirement may not be stated in the form of a separately written license, and this requirement may not be stated as aitanic unless the Major Component itself states so.

You may offer to convey a work based on the Program, or the modifications to produce it from the Program, under either of these conditions.

A "Corresponding Source" means the source code for the object code and any of the corresponding text files, in either machine-readable or human-readable form. Corresponding Source includes source code in object code form, and the corresponding text files.

The "Corresponding Source" is available under the terms of sections 4 and 5 of this License, in one of three ways:

1. You must give the Corresponding Source along with the object code.

2. You must pass on to the recipient a copy, a Corresponding Source Codice="""" file, or a Corresponding Source Codice="""" Codice="""" file containing the Corresponding Source.

3. You must pass a Corresponding Source Codice="""" file, containing the Corresponding Source, along with a file containing written offer to provide the Corresponding Source.

You may convey either the object code or the Corresponding Source.

You are free to modify a work, to combine it with other works, and to make derivative works, and to convey the resulting work as a whole, under the terms of this License, in one of three ways:

1. You may convey the object code in, or embodied in, a physical product (including a physical distribution of that product).

2. You may convey the object code in a physical product (including a physical distribution of that product).

3. You may convey the object code in a physical product (including a physical distribution of that product).

A "Licensee" means any recipient of the object code or the Corresponding Source.

A "copyright holder" is any person or entity that owns or controls copyrightable material under this License.

A "cover text" refers to the text under the terms of sections 4 and 5 of this License.

A "work" means the original program, its derivative works, and any后续 works made by anyone who conveys or modifies it.

The "GPL" means the GNU General Public License.

A "license" means any attempt to restrict the recipients of a covered work from doing anything with it.

A "propagation" means either conveying copies of a work, or making derivative works.

A "reasonable means" prior to the cessation of effective notice means the earliest time possible during and after which recipients at some location may say the words "This License applies to this object code", or if the copyright holder has made an offer of more material warranty, this means the earliest time possible after making the offer available.

A "licensee" means any recipient of a covered work under the terms of this License.

A "Copyright holder" means any person or entity that owns or controls copyrightable material under this License.

A "user" means any recipient of a covered work under the terms of this License.

A "covered work" means a work covered by this License, including both the unmodified covered work itself and any derivative works that you make.

A "User Product" is either a (1) "consumer product", which means any tangible property that is normally used for personal, family, or household purposes, or (2) anything designed or sold for use in a context related to a personal, family, or household product.

You may offer to convey a work based on the Program, or the modifications to produce it from the Program, under any of these conditions:

1. You may offer to convey a work based on the Program, or the modifications to produce it from the Program, under any of these conditions:

2. You may convey a work based on the Program, or the modifications to produce it from the Program, under any of these conditions:

3. You may convey a work based on the Program, or the modifications to produce it from the Program, under any of these conditions:

4. You may convey a work based on the Program, or the modifications to produce it from the Program, under any of these conditions:

5. You may convey a work based on the Program, or the modifications to produce it from the Program, under any of these conditions:

6. You may convey a work based on the Program, or the modifications to produce it from the Program, under any of these conditions:

7. You may convey a work based on the Program, or the modifications to produce it from the Program, under any of these conditions:

8. You may convey a work based on the Program, or the modifications to produce it from the Program, under any of these conditions:

9. You may convey a work based on the Program, or the modifications to produce it from the Program, under any of these conditions:

10. You may convey a work based on the Program, or the modifications to produce it from the Program, under any of these conditions:

11. You may convey a work based on the Program, or the modifications to produce it from the Program, under any of these conditions:

12. You may convey a work based on the Program, or the modifications to produce it from the Program, under any of these conditions:

13. You may convey a work based on the Program, or the modifications to produce it from the Program, under any of these conditions:

14. You may convey a work based on the Program, or the modifications to produce it from the Program, under any of these conditions:

15. You may convey a work based on the Program, or the modifications to produce it from the Program, under any of these conditions:

16. You may convey a work based on the Program, or the modifications to produce it from the Program, under any of these conditions:

17. You may convey a work based on the Program, or the modifications to produce it from the Program, under any of these conditions:

18. You may convey a work based on the Program, or the modifications to produce it from the Program, under any of these conditions:

19. You may convey a work based on the Program, or the modifications to produce it from the Program, under any of these conditions:

20. You may convey a work based on the Program, or the modifications to produce it from the Program, under any of these conditions:

21. You may convey a work based on the Program, or the modifications to produce it from the Program, under any of these conditions:

22. You may convey a work based on the Program, or the modifications to produce it from the Program, under any of these conditions:

23. You may convey a work based on the Program, or the modifications to produce it from the Program, under any of these conditions:

24. You may convey a work based on the Program, or the modifications to produce it from the Program, under any of these conditions:

25. You may convey a work based on the Program, or the modifications to produce it from the Program, under any of these conditions:

26. You may convey a work based on the Program, or the modifications to produce it from the Program, under any of these conditions:

27. You may convey a work based on the Program, or the modifications to produce it from the Program, under any of these conditions:

28. You may convey a work based on the Program, or the modifications to produce it from the Program, under any of these conditions:

29. You may convey a work based on the Program, or the modifications to produce it from the Program, under any of these conditions:

30. You may convey a work based on the Program, or the modifications to produce it from the Program, under any of these conditions:

The GPL should be available to you to read online.

You may not convey a work based on the GPL to others, unless you first obtain permission from the copyright holder.

You may not distribute a modified version of a work based on the GPL, unless you first obtain permission from the copyright holder.

You may not convey a work based on the GPL to others, unless you first obtain permission from the copyright holder.
from that copyholder, and you cure the violation prior to 30 days after receipt of the notice.

Termination of your rights under this section does not terminate the licenses of parties who have received copies or rights from you under this License. If you cease distribution of the Document in accord with section 10, then your licenses to distribute copies you have made will terminate at the end of yourTerm, but the licenses to copy or distribute copies you received from others do not terminate as long as those others do not have Termination notices to you.

19. No Endorsement

No Nothing in this License restricts the trademark or other marketing rights of any Grantor."
A "Combined Work" is a work produced by combining or linking an Application with the Library. As used herein, "this License" refers to version 3 of the GNU Lesser General Public License, with the special exception that this License and any other added Notice must be embedded in all new versions of the Combined Work, to the extent specified in this License. The Combined Work need only contain one copy of this License, and multiple identical Invariant Sections may be replaced with a single copy. If there is a cover text, then any included version of this License must be embedded in violation of this License, and the cover texts of the Library as you received it specify that the Library may be redistributed under the terms of this License, then your license from a particular copyright holder is reinstated (a) provisionally, unless and until the Copyright or other relevant person notifies you of the violation by some reasonable means, or (b) permanently and irrevocably, if you fail to notify the Copyright holder within a reasonable period of time in writing after becoming aware of the violation. If you remove a Notice embedded in the Library, you must remove all references to that Notice in violation of this License, and the cover texts of the Library as you received it. In other words, the name of the author of the Library as you received it must be restored on all copies covered by this notice, as moreover specified by the Library as you received it: if the Library as you received it specifies that the Library may be modified or distributed under the terms of this License, then your license from a particular copyright holder is reinstated (a) provisionally, unless and until the Copyright or other relevant person notifies you of the violation by some reasonable means, or (b) permanently and irrevocably, if you fail to notify the Copyright holder within a reasonable period of time in writing after becoming aware of the violation.

Moreover, your license from a particular copyright holder is reinstated for modified versions under the terms of this License whenever a modifier makes an object code modification to the Combined Work under the terms of this License, provided you include a notice in the object code modified work indicating that you added those object code changes. "This License" refers to version 3 of the GNU Lesser General Public License, with the special exception that this License and any other added Notice must be embedded in all new versions of the Combined Work, to the extent specified in this License. The Combined Work need only contain one copy of this License, and multiple identical Invariant Sections may be replaced with a single copy. If there is a cover text, then any included version of this License must be embedded in violation of this License, and the cover texts of the Library as you received it specify that the Library may be redistributed under the terms of this License, then your license from a particular copyright holder is reinstated (a) provisionally, unless and until the Copyright or other relevant person notifies you of the violation by some reasonable means, or (b) permanently and irrevocably, if you fail to notify the Copyright holder within a reasonable period of time in writing after becoming aware of the violation.

Moreover, your license from a particular copyright holder is reinstated for modified versions under the terms of this License whenever a modifier makes an object code modification to the Combined Work under the terms of this License, provided you include a notice in the object code modified work indicating that you added those object code changes. "This License" refers to version 3 of the GNU Lesser General Public License, with the special exception that this License and any other added Notice must be embedded in all new versions of the Combined Work, to the extent specified in this License. The Combined Work need only contain one copy of this License, and multiple identical Invariant Sections may be replaced with a single copy. If there is a cover text, then any included version of this License must be embedded in violation of this License, and the cover texts of the Library as you received it specify that the Library may be redistributed under the terms of this License, then your license from a particular copyright holder is reinstated (a) provisionally, unless and until the Copyright or other relevant person notifies you of the violation by some reasonable means, or (b) permanently and irrevocably, if you fail to notify the Copyright holder within a reasonable period of time in writing after becoming aware of the violation.

Moreover, your license from a particular copyright holder is reinstated for modified versions under the terms of this License whenever a modifier makes an object code modification to the Combined Work under the terms of this License, provided you include a notice in the object code modified work indicating that you added those object code changes. "This License" refers to version 3 of the GNU Lesser General Public License, with the special exception that this License and any other added Notice must be embedded in all new versions of the Combined Work, to the extent specified in this License. The Combined Work need only contain one copy of this License, and multiple identical Invariant Sections may be replaced with a single copy. If there is a cover text, then any included version of this License must be embedded in violation of this License, and the cover texts of the Library as you received it specify that the Library may be redistributed under the terms of this License, then your license from a particular copyright holder is reinstated (a) provisionally, unless and until the Copyright or other relevant person notifies you of the violation by some reasonable means, or (b) permanently and irrevocably, if you fail to notify the Copyright holder within a reasonable period of time in writing after becoming aware of the violation.